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=—2# CYPRESS

PERFORM

PSoC® 1 M8C ImageCraft C a—RRi#1t

1. ROM & U RAM EFHE% KT % PSoC Designer
EILE Aytg—

Cutput

Shaowe autput fram: § Build v

:;’main.c I
Linkin.g..

data durmp at output/Code0 ptimization_PSolC.idata

ROM 4% full. 543 out of 16384 bytes uzed [does not include absolute areas).
Fshd 1% full. 2 bytes uzed [does not include stack uzage).

Built with ICCMBC STD W7.05.00

CodeQptimization_FPSoC - 0 enorz) 0 waming(z) 10:13:05

Oukput

KDt a>TIE,. FAPII LRILDOBREILHRE. TD
#BWNODDIA—T AT HARSAUIZDWTERBELET,

Javzyk LRILDEEE

Project>Settings M., #3D PSoC Designer I—F & i@
LREEFATEETY

BE 1 BEETREGI—FBIIRTRLR

PSoC Designer 7AY A E LRSI BFEEIZ, ImageCraft
aAVIATlE C T7AINETETY) TPAIVIZERLET,
ZFLTCT7EVITSNENLT LT T7AIVEREBRHEA
AFITSTOr T7AIVIZERLET, REIZ.U2H—DEE
BABEGATOIb J7/ILEHEEL, EITHEEL . hex 77
AIWVEEBLET,

A—H— a—KRIZMA T, .hex F7AILIZIZBEBIERENT-
VEIEa—K (F—t3—F) NEFhTVET, KT, T—
b O—KROYEEERTREIZT 2= D—ED TS5y a N(+E
FHTD=DICHEET D, —BD NOP ishHYET X 2
FBBLTEEN, T—F O—FOEZICO—FE®RHMIC
BB D&k, 759 a AR—REHHNTEET,

2. PSoC Designer 7AC I HM ISy 2 A <97

Start

0x0000
BOOT
End ~
NOP
N.OP
Start :
PROGRAM
CODE
End

Project>Settings ##E#RL T PSoC Designer [Z&Y., 21—
HP— I—FORBT7FLRAEEETEET . B 3 ITRT L3I
AT T VT T B4R T, ILinker [ &:&IRLET

3. BRRERREAI—FBBTFL ZADER
‘;’} Project Settings

CodeDplimization_PSoC
= Build

Selected C compiler. | IMAGECRAFT

Compiler | Relocatable code start addiess: Dx| 1390
Linker

Debunger Object/library modules;

Chip Editor

Additional lirary path

THERRAF RYIRARICANTEHTFLRIE, B 4 TRUF&SIZ,
2y 74l (mp) TROFENET—F a—FDHAXIZ
EOWTWEY,

4. PSoC Designer 2851157y T T7A/IL

Workspace Explorer ~ 0 X
j Warkzpace 'Code0ptimization_P5oC' [1 project]
=I-|.Z CodeOptimization_P5oC [CY8C28445-24PVXI]
= & Code0 ptimization_PSaC [Chip]
=1\ Loadable Configurations
[ codeoptinization_psoc - 0 Uzer Modules
E Codel ptimization_PSoC [Pinout]
=& Codelptimization_PSoC
—I-{.Z Source Filez
|ﬂ mair. o
2, boot.azm
#-_1 Header Filez
+- 1 lib
[5] flashsecurity.tat
= Output Files

Codelptimization_PSol.mp

+ 1 ORI T e

IvT TrAILIE, 5 ITREATWSESIC, HLHa—KR
IVT7ORBTFLRABLIUR T ZPRLRERRLET . T—F
I—KRIFITOPITY7IZHY . CHEARADI—KRIFMitITUTIZH
VEST. X 3 OBFEETRELI—FBRB7ZFLREITOPITY
FTORTFRLRIZRELTISV 2 AR—RERHLIEN
IZERATEET, EXE TIHILLDEREIL 0x190 (Tlity
TYF7DEEDT7RLR) T, chE 0x151 ((TOPITUT
DRBDTRLR) IZEFEFTSHE ROM [TE5(Z 63 (0x190 —
0x151 = Ox3F) /N +FEETEET,
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PSoC® 1 M8C ImageCraft C a—RRi#1t

5.mp Z7AIIZHEITBMitIELUITOPITY 7

Project: output/CodeOptimization PSoC

Build Number: O

Date: Hon Mar 19 10:19:03 z01z

Compiler: 1ccmec

Version: 7.05.00

irea Addr  Size  Decimal Bytes [Attributes)

lit |o1s0 | ooFz = z42. bytes (rel,con,rom, lit)

Addr Global Symbol

0130 LoadConfigTBL_codeoptimization psoc_Bankd
01F3 LoadConfigTBL_codsoptimization psoc_Bankl
023z _ lit_end

hrea Start End Decimal Bytes (Attributes)

ToP 0000 | 0151 337. bytes (abs,ovr,rom, code)

kddr Global Symbol
0080 _ Start

014E _hGetPowerSetting
014E hGetPoverSetting

BRETELZI—FRBRTZFLANITOPIOZEDOTRELR
FYLEMEICHRESNDE, T5— AyE—UDRRINE
T, f=EZIE EF 0x150 [TEREL. T—k O—FA 0x151 T
BhHHEE . H6ITRTEIIIIIS— AvtE—IUNRRENE
ED

6. BEREF#EAI—K PRLAAT—k 3—FDH 1 X &Y
HEWNMEEDIS—

Qutput
‘Show autput fram: | Buld hd

Linking..
Lkt info: area vitual_tegisters uses 2 bytes in SRAM page 0

BRE 2 avIsFaL—av oAt
I—F&REBEILDES 1 DDA T avId, #BEFFD PSoC LY
RADHEETT . B 7 TR KIS, LORADIENL Loop
(JL—7) E£1=IZ Direct write (EIEZEEAH) V52 AR%E
FRALTHRETEET ., A ToavEFERTBICE.
Project > Settings #:&3iRL. XK 521K Tl Chip
Editor 1Z 21y LTZELY,

Loop ARZEHEATDE. LY RE PRLABIMEDRHE
FEh, EREBICIVRADENARGTRFLRICEEAE
NET, Direct write AREFERTHE LORFEY 1D
D MOV &HFEVSHERATLO AINEEESAAFET,

BREWEFER.BBEHEAEZT7A40L
PSOCConfigTBL.asm THE{LEINES, Chb 2 AKDD
—KRlE. K 8T RENFET,

7. A0 74FX 2 L—2a W HIE D EIR

o Project Settings
CodeOptimization PS5 ol [] Lock device configuration Enable project update
= Buid ] Enable interrupt t trol
Compillr nable interrupt generation control
Linker [] Enable configuration name prepending for pin name
Debugger
Chin Editor Configuration initialization bype

() Loop [size efficient] () Direct wiite (speed efficient)

8. l'Loop & Direct write JOa—F M3ELY

LoadConfigTBL codeoptimization psoc_Bank0: LoadConfigTBL_codeoptimization psoc:

; Global Register walues Bank 0 MBC SetBankd

dh 60k, 2Bh : InalogColwwn’| »  Global Register values Benk O

dh 66h, 00h ; AnalogCompare mov reg[60h], 28h + AnalogColumn

dh 63k, 0Sh ; AnalogReferer nov reg[66h], 00k ; AnalogCowpars

dh 65h, 00k ; AnalogfyneCor mov reg[63h], 0Sh ; AnalogRefere:

db e6h, 00h : DecimatorCont mov reg[65h], 00k ; AnalogiyneCo:

dh e7h, 00h ; DecimatorCont mov reg[egh], 00h ; Decimatorcon

dh deh, 00h 5 I2CConfig rec mov reg[e7h], 00h ; DecimatorCom

dh b0k, 00k ; Row_0_InputMy niov reg[dfh], 00k ; IzCConfig re
Loop Direct Write

8 #RBHL BLORAEEAHFADI—ER DM B LS
HYFJ, Direct write AXTHERENSHI—K (MOV
reglexpr]. expr = 3 /3 k) & Loop AXDI—F (addr. {&
= 2/8(b) &Y 1 N\AFBULVTY, LHL. Loop AxIZE 94
NAMERTAREAHLEHENEENTVET . TDH.
A—KRFBLOREM 94 EULDHE (Chik, REEHL
Designer F7OCzIMEBRKTRTDHZEIZHK LT ). Loop
ATaAvEERTHEERT LISV 1B 2 EVHBYE
T B 8 ITRENTNAIY ¥ aL—avREFERALTH
BIESNEL R 20 HIE, BFEICERAINE)Y—X (—
Y— EVa—)L) ORIEKFLET, UY—REERTED
REWFE, BZLOL DRI GELSNET, ZDI=H. T
HAUNZTSYLaG D=0 1—F— ED1—ILHZ<E
FhTHEY. BHIZDLOBMMAM>TENTEHLENEE.

Loop ARZFERALFET., THAVIZZELDA—HF— D2
—LEFS>TULRL, FIEKYEERLET NI RDEBEEFE
575, Direct write ARXEBINLET,
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PSoC® 1 M8C ImageCraft C a—RRi#1t

BRIE 3. YT A—Tay (Sublimation) EavT
vt—33> (Condensation)

HTYA—=23> (sublimation) LUV TFTrE—ay
(condensation) [%. ImageCraft Standard KR hME# 3 5 EHE
Bffitd, K 9 IZREN TS KLSIZ Project>Settings #
BIRL, RyTT7vT 91Kl Compiler1&5)vo3 5
ETREETIENTEET,

9. ¥ J1A—3> (sublimation) LA Frt— 3y
(condensation) AT 3>

- Project Settings B
Codelptimization_PSoC Select C compler. | IMAGECRAFT ™
Buld
Conpiler Macro defines
Linker
Debugger

Chip E ditar Macro undefines:

[ Optimize math functions for speed  [7] Enable MAC

Enzble paging Stack page: | Page 3

Stack page offset. |0

Code Compression Technologies
[ Condensation (duplicate code)

[] Sublimation [eliminate unused user module AP1s)

(@) Treat constas ROM () Treat const as RAM

YT YA—3> (Sublimation)
FSublimation |A 7L av&#IRT BHBE. AV (5H1—
Y— EVa—)L APl ({>A—Tx—R O2—F) [ZBITEKE
AOBEHBEHIRL. TRIZKYRR—REFHHLET,

&2 1E. FTOP IR PGA LU PWM 2—H— ED
A—LEFHBEL.MADI—Y— EVa—)LIZTStart | B
BOAEFUVHTIENTEET, K 10 BLUR 11 (TR
IhTLWAESIZ. D1 —H— E2a—)L API IZH
WTAFEROBEREZHERTHEIZEY 142 N(+D Ty
VABREEHNTEET,

10. HITYA—La EFRLALEE D ROM EAKR

g T
Linking..
LAk info: area virtual_registers' uses 2 bytes in SRAM page 0

ata dump at oufpulLode0ptmizahon_PooC. idata
ROM 5% full. 754 out of 16384 bytes used [does nat include absolute areas).
Rk 1% full. 2 bytes used [does not include stack usage).

11. YTV A= 3 % ERHT 51580 ROM f# KR

Output
Show output from: | Build v

Jmainc

Linking.

LMM info: area 'vitual_registers' uses 2 bytes in SRAM page 0
symbol PiA_EnableAGNDBufer is unused
symbol PWM_Stop is unused

symbol PWM_Disablelntis unused

symbol PWM_wReadPulsewidth is unused
symbol PGA_DisableAGNDBuffer is unused
symbol PWM_WirtePulseWidih is unused
symbol PWM_WitePeriod is unused
symbol PGA_SetGiainis unused

symbol PWM_wReadCounter is unused
symbol PWM_Enablelrt is unused

symbol PGA_Stop is unused

142 bytes unused code deleted «Emmmmmm—

v o f T
ROM 4% full. 513 out of 16384 bytes used [does not include absalute areas)
RAM 12 hull 2 bytes used (does not include stack usage)
Brtrrrteemse-srerroan

Output

FTRTOIA—H— EPa—J/L APl OE&BE#ENTAPIHIT
FRISATLSEE. K 12 IZRESN TS ESIZ, Tno dead
symbol found (TYF SURILBRDOMYFEHATLE)IEN
Styt—UhRRINET,

12. T'no dead symbol found | Ay E—CMNRRE S
HIT A= 3y

Qutput @

| Show output from: [Build v‘
WM ipfo- arez idial padictersyicae I butesin SRAM page 0
Ino dead symbol found .

b b= (0] o= 0 10 LW T (=20 11 ot o] T [ = =]

ROM 4% full. 578 out of 16384 bytes used (does not include absolute areas).
RAM 1% full. 2 bytes used (does not include stack usage).

Built with ICCM8C STD V7.05.00

CodeOptimization_P SaC - 0 emon(s) 0 wamingis) 13:40:13

ar5Frv+e—3a> (Condensation)

Condensation #7723V #RT HI5E. TOP I+ THRY
BENDa—RDES AVFRICE#MI RSN, ZOa—FD
BAVRAVADEHEVHLUICEERAONFS . O—F 1
[SRENTWBBELGHITIE. TAD VDR RIS TR
Ca—FA 3 @ERYRShTOET, avTroe—avhsg
BENDE A FOE—AV RV RSB EBRIN, £
DAVAIVANFEE T HONEHE T, B 13 [TRENT
WAFIICEDEBA~DEBTUHLICEEMALONETS,
ZDEGETRTOEREN-EHKIE. B 13 ITREA TS
£31Z, a—Fn#EbHYEB Ul <created procedures>] 5L
DTFICEESNET, RITRT LIIT. 3—F 1 AICERSH
f-B8%&<created procedures>15RJLTHREYET, FD
O AVRAVADFERASNDVHRDEF T, l<created
procedures> ISR JILDFE YU HLIZCEEH®RAONET,
l<created procedures>15~NJL DA —2321052018 &
UT052BIIZ 1T HEHUE ., U LAl BAskICEH]EIN S,
TOCIMIBITEEOMDEEI—FTT,

a—K1

/* Instance one */
shadowRegs [PORT 2] |= 0x01;
PRT2DR = shadowRegs [PORT 2];

/* Instance two */
shadowRegs [PORT 2] |= 0x01;
PRT2DR = shadowRegs [PORT 2];

/* Instance three */
shadowRegs [PORT 2] |= 0x01;
PRT2DR = shadowRegs [PORT 2];
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PSoC® 1 M8C ImageCraft C a—RRi#1t

13.71st /Z7ANIZHEIFHa—F 1 @AV ToE—ay

1954 : cz LCALL <created proceduress |
1985 | j

1987 | ] ShadowRegSTPoURT 2] |= ;

1988 | )  PRTZDR = shadowRegs[PORT_Z2]:

1989 | j

2050 H ICJLLL <created procedures>|
2051 )

z05zi I

z054i | S PrTemaapa- | =

Z055 I PRTZDR = shadowRegs[PORT z]:

2140 I 1 shadowFegs[PORT_ 2] |= H

2141 : oo EEGL il

2142 H rgL <created procedures: I
21431 | I PRTZDR = shadowRegs [PORT Z]:

2215 <created procedures>:

2219 : ZE OR [shadowRegs+:2]
2220 H Mo A, [shadowRegs+2]
zzz21 : Mo REG[ 1,4

zzzz : 7F RET

Z223 : jeln] Mo REG[ 1.,

2224 H FE AND [2hadowReg=s+-2] ,
ZZ2ZE : Mo A, [shadowRegs+2]
Zz2za : Mo REG[ 1,4

2227 : 7F RET

Zzza : OR F,

zZz2z9 : CR REG[ 1.,

2230 : FE AND REG[ 1.,

z2231 : CF AN F,

ARAR : 7F RET

Condensation A7 avIc&y. B 17 ITTREN TS &KSIZ
HHUED ROM AR—RZ M TEEY, 2—FITavTFot
—2avEERTBHICE, MextiTY7IZHF5a—K (B 14
[ZRLTLND.mp 77 ILIZRBIEMNTEET) H¥ 256 /3 A+
EBZDBELHYFET, Mext]TUTH 256 /N LRFHDS
& . lprogram code in ‘text’ area too small for worthwhile
code compression](ltext/ TY7RADTOS 5L a—KiX, O
—REMBITITPSBEET) LWLVSIS5— AvE—UDHRTRS
hFEF (K 15), a>ToE—a ET50NEHEI—FD
AVRBZAMBE D BELMES . Tno worthwhile duplicate
found] (BRGEENROMYERATLE) ELVSIT5— 4
ytE—UMRREINET (K 16),

F K 15.K 16, K 17 [CRTSNBERE. 3—F 2>T>
t—avhDELEZVFIAELIZIAL— T B-HDELS
:_"0):50)—6?—0

14. . mp Z7MILADNtext1 T 7

a0

51 hrea hddr  Size |Decimal Bytes|[Attributes)
az e B

a3 text 0445 0143 = 323. bytes|(rel,con,rom, code)
a4

as iddr  Global Symiol

a8 -

a7 0445 vext_start

a8 0445 _main

EE] 0588 _ xidata_start

20 0558 <created procedures>

91 0588 _ rext_end

9z 0S8E __ xidata_end

23

15. Ttext] T 7 HS 256 A RRFEDIHZED
avTot—iay

Cutpuk

Show output from: | Biyild |

Starting MAKE ..
creating project.mk -- no changes
Amain.c
Linking..
L e Lo ) B Do o B A o e
brogram cnde in 'text' area too small for wc-rthwhlle code compression
oL 2l L ) l ! '™ T L
ROM Bé full. 863 out of 18384 bytes wzed [does not include absolute areas).
Babd 1% full. 2 bytes uzed [does not include stack uzage).
Builk with ICCMBC STD WY .05.00

16. EEI—FARDOASLENGEEDIVTUE— 3y

Oukpuk
Show output from: | Bild |

Starting MAKE. ..
creating project.mk - no changes
Amain.c
Linking..
et rrtrs=renreersrrerg butes in SRAM page 0
no worthwhlle duphcate found
AR prhrrremed_P'S ol idata
ROM 72 full. 1055 out c-f 16384 I:-_l,ltes uzed [does nat include abzolute areas].
Rk 1% full. 2 bytes uzed [does not include stack uzage].
Built with [CCMBC 5TD %7.05.00

17. 3—F 1I2BFBarToE—3y @—F1lldtext T
T H 256 INAERBZDRENTOD IO —E)

Output

Show output from: | Bild |
Starting MAKE...

creating project. mk. - no changes

Amain.c

Linking..

LMM |nfu:| arga data |tem of |} b_l,ltes allocated ] SHAM page 0
Il e e e o e TS

374 bytes before Code Compresslon 323 after. 12% reduction.

ROM 72 full. 1063 out of 16384 bytes uzed [does not include abzolute areas).
Rakd 2% full 9 bytes uged [does not include stack usage].
Built with ICCMAEC STD W7.05.00

>

AT av YU ED ROM AR—RZERADT S
M. EBEEI—FZEAHRTUHELTEE®RA S0, FOJ5 4
ETICBEEEMAET,
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F&5E 4: ROM EHoH RAM EH

ZDATay (H9%EB]) (X, 75y 1 (ROM) ICEHE
BE{ZET RAM OFERABEZAIBLTVET . 75y 10
AEZKEIZHET I2HFTREBYEREA. KEHDOTOD
TMIZIE Treat const as ROM (E#% ROM TS) 7Y
aVEEIRLET, Treat const as RAM (RAM DE#ELT
#%3) A7 aviE. £IZ ImageCraft a2/ RASDBIREDT
MEBEO-HICERINET,

ImageCraft Pro Ax/8 (5 473>

ImageCraft Standard 3> /(S TRHtSNAREILA T3
VIZHNZ T, ImageCraft Pro [£E] 18 IZTREN D KSIZF D
DATavERHBLET,

18. ImageCraft Pro Az /845 7 ay

s Project Settings
CodeOptimization_PSol Select C compiler: | ImageCiaftPio ~
= Build
Compiler tacro defines:
Lirker
Debugger _
Chip Editor Macro undefines:
Enable paging Stack page: Page 3
Stack page offset: 0
[] Dptimize math furctions for speed Enable MAC
[ Eliminate unused user module AP)s Enable code compression
() Treat const as ROM ) Treat const as RAM
PRO compilsr options:
Enable PRO [] Optimize for speed
Eliminate user unused functions

ImageCraft Standard 2> /S/ S TRESN S Sublimation
H KXY Condensation #Favix, ThEh ImageCraft
Pro a2 /XS M Eliminate unused user module APIs ] (
KEADI—HF— EZa—IL API 2HIBRT D) A FLavd
&UTEnable Code Compression] (AI—REHEEAMIZT
2) A TLavERIL T,

ImageCraft Pro [&. lEliminate user unused functions |
FILavERHELTVWET, ChiE, 2 —F—0To sk
NERTI—HF—DFEALTWAWEHEERRTHIENE
BB EIERITRISLEETS, HHYDLTVFUAFT
OPzIMN)EDIVEERDIET. READ API HAa—F
[Z3£7FL. ROM AR—RZHET DMERLHYET ., COF
TavhB\HIcEhde, a3 RERD API A0
—FIZRESN TR E, ELT ROM ZAR—ZAZE Dt
DRRICERTRETHI_LEHRLES,

ImageCraft Pro TEAAELELS 1 20T avid,
fOptimize for speed J(A—FDEREZEZEIL) T, 2D
AT avEBMCTHE A—FEKYERIZETTHLSIC
AVRAILVENFET, RBIEHSBERAEINSHAICELTROM
DOEREMNEM, FILBOLET, K a—FIZHT

BINEWIL—THEREmENEIRRESNST-6 . ROM DOfER
ENEMLET, TREEYLTELTGEEHIIEIBRSN
1= . ROM OFERMFEILLET .

EVREEUVHARSM1Y

LA DA—FT AV TRz EYAI—F —DIT7—LHTT
EEYDEMICTEIIENATEET . CAHDFE I
PSoC Designer 7ACzI+E LY PSoC 1 THEFATEETH
Y. Ff=. PSoC 3 &LV PSoC Creator™ZENEELT S 8
Evk 7Oty IDE BXKUIU/ASIERTEETT .

HARZAY 1. BlYRAHY—ER L—FUIZHIT
DB LA BB

EYRAHH—ER JL—F> (ISR) O CaA—FZa/ (LT
5154 . ImageCraft a2/ 1(5(& ISR HMERATREELDR
A (—EHEEZRET D012V ISHERTALERS) &
FTARTREYYITTYaLFT, ISRI—FICEBFUHLA
EFENTVWBIEE. AVRAFIEFVHSAERICKYIEBIE
SNBLOREER P ITHoNEE A, ImageCraft Car/ (S
. KT 15 OERBLOSR2EFERALT—BT—2E2X5vY
IZRELET,

256 /IN{+%E#BZ% RAM %A 1= PSoC FyITlE. Thi
15 DRELOREERIZ 4 DOR—D RAVEABLREEB LY
BrxEhET, 3—F 2 DFHTIE, AV RAISHAMEREL O R4%
RETIVHEEHYEEA (B 19), 3—F 3 ITRESh TS
FOICEAMTFUHLEFERLTEETSHBE. B 20 [TRESh
TWAESIZ, AU#EEETE 15 ORBLSR4EREHCERL
F9., ELORRE, ROBMDF—/N\—AYE a—FEBE
ELFET: MOV [2/84K] + PUSH [1 /34 K] + POP [1 /3AH]
+ MOV [2 /8/K T LORATEIZEET 6 /8 (k, O—F 3 1&.
INEDZLD MOV/IPUSH S D 1=, 512 90 /3 b&{E
FAL.:EBE, READ ISR E720EELET,

a—kK 2
BYTE bVarl;

#pragma interrupt handler
SleepTimerHandler;

void SleepTimerHandler (void)
{

bvarl = 1;
}

WWW.CYpPress.com
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19. BEHMEVCHLEEDEW ISR BIZEREShf-0—F

@—K2) 20. BB UHLE o1 ISR AITEREhfza—F
S @—F3)
958 [ ) #pracma interrupt_handler ZleepTimerHandler;
Q59 ( ] 990 _cleengmerHandler:
060 | ) void SleepTimerHandler (void) 991 : PUSH L
ELNS 1A 99z : MOV A, [ r0]
S62; _SleepTimerHandler: 993 i PUSH 2
aes . P o F, 594 : mov A, [ ri]
cea : PUSH L 395 : FUSH &
965 : 5D DO MOV A, REG[ 1 298 ; moy b, [_rzl
aee : PUSE 4 597 : FUSH &
sg7 ] bard = 1: EEE : MoV A, [ r3]
’ EEE] : PUSH &
968 : oo MOV REG[ 1, 1000 : wov A0 r4]
: S
z:i ; ggg )[lwa“]’ 1001 : PUSH 4
; 1002 : MoV A, [ rS]
a71 : Do MOV REG[ 1,4 Lo0s : PUSH A
272 : FOP & 1004 : MOV A, [ r6]
o973 : 7E RETI Lons : PUSH &
274 Il 1006 : MoV A, [ 7]
1007 : PUSH &
e 1008 : MoV A, [ 8]
a—k3 10039 : PUSH &
1010 : mov A, [ ro]
BYTE bvarl; 1011 : PUSH A
void TestFunc () 1012 : MoV &, [ riO]
{ 1013 : FUSH &
. 1014 : MoV A, [ ri1i]
bvarl = 1; 1015 : PUSH 4
} 1016 : MoV &, [ rX]
1017 : PUSH &
. 1018 : nov & ¥
#pragma interrupt handler R
i — 1013 : PUSH &
SleepTimerHandler; 1020 . MoV &, [ rZ]
1021 : FUSH &
void SleepTimerHandler (void) 2z i ! TestFunc() ;
H 23 unc ex Star 23 unc
1023 oF CC CALL _ TestFunc|_ text_start|_Test
{ 1024 : FOP &
TestFunc () ; 1025 : MoW [ rzl.h
} 1026 : FOP &
1027 : MOV [ rY],A
1028 : FOP &
1023 : mov [ rXEl,A
1030 : POP &
1031 : mov [ rii], A
1032 : POP &
1033 : mov [ riol, 4
1034 : FOP &
1035 : MoV [ r9],d
1036 : FOP &
1037 : mov [ r8],A
1038 : FOP L
10339 : mov [ x71,4
1040 : POP &
1041 : Mmov [ rél, i
1042 : FOP &
1043 : MOV [ r5],A
1044 : FOP &
1045 : MOV [ r4],d
1046 : FOP L
1047 : mov [ r3l, i
1048 : POP &
1049 : mov [ r2l,i
1050 : FOP &
1051 : Mow [ ril.d
1052 : FOP &
1053 : oW [ r0],d
1054 : FOP L
1055 : 7L RETI

WWW.CYpress.com XE%S: 001-82519 Rev. *A 7



(YPRESS

PERFORM

PSoC® 1 M8C ImageCraft C a—RRi#1t

HARSA4Y 2. EffiEABOERZHIR

ZLDBE. CAVvNRIIFAUS5(> PHUTS O—F%&ER
LCHBELEMTEERTLET . LhL. B#LEEICDL
Tk, KHYIZ 1 DFLEEFAULOERSATSUESZED
—RIZEBMTZIEABYET, SAIEENEIZIEAESMIGES
BOATREMNHYET ., LEBEBSIUEHOBHEICIVET A,
T+ T-1 T T To%), T 1 BEUT<1D K57 B ffi%E C /&
BEFCERLSAMTSVBEBERTRICBRELT HIENAHYE
ED

ENoIATSVEBEBOTHERNTEHERETI N, 5175
VBRI HEI=AFRTERNELDI—F AR—RELHDHD
CEDRBYET, ZDBE, THRLI-FEEFEIR
REBETBHEITKY . SATS5)BEDIBE D E A% E#
TEEY,

TRUSLNBYEREERTHEE. FRASNLIEROY
AXELVIEEE (8,16 F=[X 2 EVb. FEMFEFELIEIFE
TL) ISIECTHEMSATSVERAEMENES . HcE
HDONAMEFAEIZEST HEEMIE. Help > Documentation
> Designer Specific Documents MO TF® Libraries User

Guide [CERESNhTLET,

EBEMNEHR (bbb EICHERAINTLDEE) (2E, B
DIE,. BESLIVVIMNETATOET, RELGEDE
DHDEENFEASINDIEGEE. CNODEEDI—FLEE
nxy,

ZEREORDYIZO IS IUVUMEEZHER
BELLEHOEBREOKDYICEYS DIMBLUMED K
SHINEEFERTACElF. O—F AR—XEHHLET, &
SHLEHTE. BE—DEYREEDOLINEN 2 IZXEHBE
[CHBL. CTREMN 2 [TEBFEEICHHELET . O—F 51
RS OTNBLUVMBEZERTHILT. FRESAD
SYBEHZEECLERIHYFE A,

RICHERZEH-5TRD 2 DNDA—FDR=ZRYLTIE K 21
EE 22 [ITREINTWAKSIZ, O—F 4 OEE(FO—F 5 &Y
55 NARBLFERALET . ZOEWNE. 3—FIZT mullé6]
BHMAEMEIN TS T,
a—kK4
unsigned int iTestl, iTest2;
volid main (void)
{

iTestl = iTest2 *3;
}

21.3—K 4D ROM FHE

2ukpuk
Show output from: | Bl

Starting MAKE...

creating project. mk, - na changes

/i,

Linking..

LMM info: area 'vitual_registers’ uses 4 bytes in SRAM page 0
LM info: area 'data’ item of 2 bytes allocated in SRAM page 0
LM info: area 'data’ item of 2 bytes allocated in SRAM page 0

idata dump at output/CodeOptimization_PSoC.idata
RO 5% full. B30 out of 16384 bytes used [does not include absolute areas).
Rt 2% full. 3 bytes uged [does not include stack uzage).

Built with ICCRMEC STD W7.05.00

a—K5
unsigned int iTestl, iTest2;
void main (void)

iTestl = (iTest2 << 1) + iTest2;

22.0—K50M ROM {#AE

Qutpuk
Show output from: | Byl ¥

Starting MAKE ...

creating praject.mk - no changss

Amain.c

Linking.

LMM info: ares 'data’ item of 2 bytes allocated in SRAM page 0

LMM info: area 'data’ item of 2 bytes allocated in SRAM page 0

LMM info: area wirtual_registers’ uses 2 bytes in SRAM page 0
program code in 'test’ area too zmall for worthwhile code compression

T a 3 -
RO 4% full. 625 out of 16384 bptes used [does not include absolute areas).
Rabd 1% full. & bytes used [does not include stack usage)

BT with TCCMGL o 10 w7 0o

EBEHERTS
ERRLEMBEESAISEHREEBMLET . BERKEE
DLTEEFIIREBFREEETIHILLTEET IR
I£, 4°= 4x4 T, BIOEIL 3V THRBALIEESIZ, RBRE
E. V7B LUMEFFALTERITTEEFT, TDEH.
NoBEBOREFTEIRYL IS IUMEICHRET S
EICEY BONF-ENBEEKEHFEITZTOIILIZENT
O—RR R—RZHWTEET,

BB/ BREEOEE
8 Evk TRty Y DERE/NNIRERR. RITEIZST4TFY

BREWELLEY, EREMEEERTHOBRICINAT,
MERA. ERIEBSUHFANGEHOREDT-HDH AR
HEIO—FIZEBMNESNSAREELABHYET ., FE/NESAD
SYDEMIZ DL TIX, TArithmetic Libraries User Guide]
(BESM473) 1—H— HAF) #5BLTEEL, HBEE
LTEEETIC. ROZFH/NMABRICHELRI—F XR—
RIFUTDEYTI (TArithmetic Libraries User Guide | (&
ESA(T3) a—H— H4AR) ICHEEIhTLED),

LE#R (*_fpemp) = 109-125 /3 A b
& (*_fpadd) = 461-478 /A k
BE (*_fpsub) = 468-485 /A +
F|H (*_fpmul) = 406-558 /A +

WWW.CYpPress.com
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BRE (*_fpdiv) = 432-449 /A k

FEN R EMBERIE. BREMSAISVER—RELTE
ALET, Ihld. RS EEFFERAT R, BHE
MSATSVLRBEELDILEZEKRLET ., F/INAEE
FEATIRDYIC. EROHEHLBREMNDIGEE (X, EHER
T TEHERZEEFERT LN TEET,

FEZEUTO 2 2OO—KRTIL, ZHOERE T/ AL
TEIMETTHAENHBALTNET, D=0, TT

DFE/ N AL 100 FHMTEE. FE/NSEEORDY
[IBHEEFFRTEET, ZOFITIE. X 23 BLUEK 24
'-Témfl:‘%):kj'-s 'ﬁl/ﬁ%/ﬁ@j K7 0)1§Fﬁ5‘i\ AN
BOBLCEANZES/N S AZRL-O—F 6 &Y 761 /Nt
BLRYETS,

a—k6

int iTest2, iTest3;
float fTestl;
void main (void)

{
fTestl = iTest2 * ;
if (fTestl > )
{
iTest3 = 7;
t
else
{
iTest3 = 1;
}
}

23.0—F 6 M ROMEA=Z

Cukpuk

Shaw output from: - Byild i

et o
libprvmint. asm

./boot. asm

fmain.c

Linking..

LMM info: area irtual_registers’ uses 7 bites in SRAM page 0
Lkt irfo: area 'data’ item of 4 bptes allocated in SRAM page 0
LMM info: area 'data’ item of 2 bytes allocated in SRAM page a
LM infio:_area 'data’ item of 1 bytes allocated in SRAM page O

lata dump at output/Codelphimization_PSol. idata
ROM 102 full. 1480 out of 16384 bytes used [does nat include absolute arsas).
Rak 2% full. 14 bytes uzed [does not include stack uzage)

uilt with [CCMEC STD V7.05.00

a—K7

int iTestl, iTest2, iTest3;

24, 3—K 7® ROM FHE

Cukpuk

Show autput from: | Biild 1

Starting MAKE ..

creating project. mk - no changes

Amain.c

Linking..

Lk info: area “virtual_registers' uses 4 bytes in SRAM page 0
LMM info: area 'data’ item of 2 bytes allocated in SRAM page 0
LMM info: area 'data’ item of 2 bytes allocated in SRAM page 0
LMM info: area 'data’ item aof 2 b_l,.ltes allocated i in SRAM page 0
II_IﬂI.ﬂ TR At A L U T Qnrar_ s, II.IﬂI.CI

ROM 5% full. 719 out of 16384 bytes used [does not include absolute areas].
Rab 2% full. 10 bytes used [does not include stack uzage].
B Wit ICCMes o 10 7 7 0000

HEOKRDYIZILYITYT T—TNLEHEH
HEXYLILYITYT T—TIU (LUT) ZEALEIFS A=
HZEEAHbYET., EE. EEESKVI—F AR—Z#
EBBONL—FFIDHBYFET, 7TUr— 3> niEHaIC
IECTEIRLET,

f=&Z £, AN2017 — PSoC 1 DH—IRZIZKDBERIE T
BN TOOIMNL, FE/NMRB LY LUT ETEE
FTEATa ERBHBLTWET, SOTRPHMTIEZEEND
HAEEORDYICLUT AT DI LICLYAEYE 4187
N Lo TyT F—=TILRD 3779 13+, ZEI/INE S
BXA®D 7966 /3\1F) HIMLET O BEDIL—FATHH
YES,

T—AREO—REOHE

EHOT—HRERIRTHHIL., BERICHDBELESNSRE /NS
WTF—HBERIRLET, FEZE EHORKMEN 256 #
BAEWMEAIE int DRHYIZ BYTE 2BINLET, RHRIC,
HEATRERIGE T, FEAEEHORDYICHELELES
FERLET. HIAIE. TOVSLDICENTE#Testll&
lTest21A 255 Z A GMER . 2—F 4 E#&RELET, &
D/ E.I—F 8 IZRFT K3IZTunsigned int1DRHYIZ
lunsigned charlEL TEE T H5IEMNTEFET, ROM FH
2(FE 25 [TRENTVET . I—F 8 [FT—F 4 &Y% 84 N\

FMOGECHELET,

a—K 8

unsigned char cTestl, cTest2;
volid main (void)

void main (void) {
{ cTestl = cTest2 *3;
iTestl = iTest2 * ; }
if (iTestl > )
{
iTest3 = 2;
}
else
{
iTest3 = 1;
}
}
WWW.Cypress.com XEZS: 001-82519 Rev. *A 9
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25.0—K8®M ROM {E#AE

Oukpuk
Show output from: | Build i

Starting MAKE .

creating project.mk -- o chahges

Amain.c

Linking..

LMM info; area wirtual_registers' uges 2 bptes in SRAM page 0

LAt info: area 'data’ item of 1 bytes allocated i SRAM page 0

LAt info: area 'data’ item of 1 bytes allocated in SRAM page 0
program code in 'text’ area too small for warthwhile code compression
“..ICIlCI LT Ot UL, I_aUI_IUUPI.;III; Cll;UI I JUL.;UCILG

ROM 4% full. 596 out of 16334 bytes used [does not include absolute areas)|
Rabd 1% full. 4 bytes used [doesz not include stack uzage].
Bt S Tt

BEMNEZEHOESIVEOHEANHIBALIIES. TOEH
9oL TCEEICL. FELLOEMBAREFERATEET, R
BRIC. ZEHA-10~+10 OEERNDEEETHIENRAE
NBBE. 3—K 0 A-10 1T ELTI—FK 20 A+10 23R
TEHLI [EF10FTHLET,

I—K ZAR—REWSATEF YR T4V J XEMETH D=0,
FRSNSET—2EO—EM%#H#HIELET., TATSLICHE
WTEX YR TV DERNBAEDIGE . BEfiZ4T3VD
OA—RRAR—REHHT 5012, THOBEXvRAT405 L
TRILEMSATSIVEFERLET,

HARSAY 3: BIAUTYVIRARRA4A

BHA 2T v RETIE, ImageCraft 14Ty I AZFEAL
TET7RLRIZEETIVRALET, FRLREEHOEFE
B5=0. HERIBREHVERA, RIVE FIEADEAR.
BT IVEREERTHAIRAURAIZEDINTLNET, Lizho
T AVNRASETRLREAFTEE0I12, KUSDFHEE
ETTIHLENHYET,

FORREMREVRLERSNDIES . T/ EADEEDEN
MAEYEREBICKIBREILELOLES,

FEZE UTO 2 DOa—KRFIZDNTHREILET . B 26
BEUE 27 ITRESNTWAKSIZ, 2—F 9 [Fa—F 10 &Y
25 NALZLERALET, TDRH. FRSNDT7IERAE
DFEFE (BRI TIVIRRKRALR) #EEREBRT DL
. 3—FORBILIZES>TEETY, 7V RADEELLV
EHOBAICEIKZLDON)I—a0hHBYET, FRLR
PREHTHD (FOBEEITIFAVIISATRLRAEEIEIZE
TR D) CEDOHERNF—LABYFET, RITHRICTRLRE
ENDELRIEE ., AV 151FEYELDI—F AR—R%E{#
BALET, — MBI [>IBEFEFO—F AR—RENSETEH
HTY,

a—kK9

typedef struct
{
int iData;
BYTE bData;
}sData;

typedef struct

{
sData myArray[10];
}sArray;

sArray myTest;
sData* myPtr;

volid main (void)

{
myPtr = myTest.myArray;
myPtr->iData = ;

26.3—K 9 M ROM FHE

Cukpuk

Shiawe autput frar: B Gid HEYS

Starting MAKE...
creating project.mk - no changes
Amain.c
Linking..
LMM info: area 'data’ itern of 30 bytes allocated in SRAM page 0
LMM info: area 'data’ item of 2 bytes allocated in SRAM page 0
|t info: area “vitual registers’ uges 2 botes in SRAM page O
data dump at output/Codellphimization_P5olidata
RO 4% full. 612 out of 16384 bytes uzed [does not include absolute areas).
Fabd 5% full. 34 bytes used [does not include stack usage]
Built with ICCMBC STD 4 7.05.00

a—K 10

typedef struct
{
int iData;
BYTE bData;
}sDhata;

typedef struct

{
sData myArray[10];
}sArray;

sArray myTest;
sData* myPtr;

void main (void)
{

myTest.myArray[l].iData = ;
}

WWW.Cypress.com
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27.2—F 10 ® ROM {£RE

Dukpuk
Show output from: | Brild hd

Starting MAKE. ..
creating project.mk -- no changes
Amain.c
Linking..
LMM info: area 'data’ item of 30 bytes allocated in SRAM page 0
LMM info: area 'data’ iterm of 2 bytes allocated in SRAM page 0
Lt info area 'wirtual registers' uzes 2 butes in SHAM page O
idata durip at output/ Codel ptirmization_FS ol idata
RO 4% full. 587 out of 16384 bytes uzed [doez not include absolute areaz].
Rabd 5 full. 34 bytes uzed [does not include stack usage).
Built with ICCHEC STD W7 .05.00

HARSALY 4. RAYFXE if-else XDFEFH
FHHIMIE, RAYFXFER(L if-else XDEELNEFRT
=T, 2 XOWEAF. RIYFIXHEIZ 16 EVbDHER
EFHDIZXLT, if-else XHNEILTHIRICEDNTHES
TWET, 1L N\AFOEH (BYTE) DIBE. ImageCraft >
INASIL, if-else XHEFEHTHET, RAYFXELERTKY
PEMBEI—FEEVELET, ChiE. 8 EvtDLEA WY
BEL9Ha—F AR—XI[E 16 EVrDLEELY DEN=6HT
ERD

AAYFXILEBMT 9 /A b, SHIZET—RIZDES/N(+%E
FRALET, fEAE I—F 11ISRSA TS K5 T I+
IWEDIEBEZEBA 4 T—RDRAAYF XL, ;

break;
t
case
{
bTest2 = 7;
break;
}
case
{
bTest2 = =;
break;
}
default:
{
bTest2 = 4;
}

}

28 BKLUE 29 ITTRENB LS, BHDI—F 12 £U%
(9+4x4)=25 /" +ZLFEALET

a—k11
BYTE bTestl, bTest2;

void main (void)

{
switch (bTestl)

{

case

{
bTest2 = 1;
break

}

case

{
bTest2 = 7;
break

}

case

{
bTest2 = 3;
break;

}

default:

{
bTest2 = 4;

}

}
28.0—KF 11 M ROM ERE

Cukpuk

Show output fram: | BLild HE™

Starting MAKE ..
creating project. mk - no changes
Amain.c
Linking..
Lkt info; area "wirtual_registers' uzes 2 butes in SRAM page 0
MM info: area 'data’ item of 1 bytes allocated in SRAM page O
LM info: area 'data’ |tem of 1 b_l,Jtes allocated in SRAM page 0
e T
ROk 5/ fuII 55? out Uf 16384 bytes wsed [doesz ot include abzolute areasz).
Rakd 1% full. 4 bptes uzed [does not include stack usage).
BT Witk TCLTA B0 = 10 w700 00

a—k 12

BYTE bTestl, bTest2;
void main (void)

{
f(bTestl == %)
{
bTest2=1;
}
else 1f (bTestl == 2)
{
bTest2 = 7;
}
else 1f (bTestl ==2)
{
bTest2 = 3;
}
else
{
bTest2=4;
}
}

WWW.Cypress.com XEZS: 001-82519 Rev. *A 11
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=

29.3—K 12 M ROM FRE

Cutput

Show output from: | BLild |

Starting MAKE...

creating project. mk. - no changes

Amain.c

Linking..

Lk info: area "ittual_registers' uses 2 bytes in SRAM page O
LMM info: area 'data’ item of 1 bytes allocated i SRAM page 0

Lk info: area 'data’ item of 1 bytes allocated in SRAM page 0
. irizabioe, BSol idat

Rab 1% full. 4 bytes used [does not include stack usage].
Evilt with ICCHEC STD 7.05.00

ROM 4% full, 632 out of 16384 bytes used [does not include abzolute areas].

SEHHIMA 2 /NAES (WORD) MITTHIIEE. RN
Ba—K A XFENThOREICEWTHIEIER—TY .

WWW.CYpress.com
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HARSAY 5. PO ITSTa—FDO—EHEEL
T TSTTOTSLEELIEIZEY ., AV II1SDBRR
FEEL. B2 —Y—R#ELETREICLET. 7EVIS
TIOVSLEREECCLITRETEHOLLTT A, O—FD
—EEFETEOTVEBICEBRTHILICKYa—FDF A
ARNTH—IRERBILTEET, 2—F 11 D&K3IZ. 7
2 JYT bTest2 EHADENY LB TEHEST—F 13 #HEL
F9. 30 D&L3IZ, a—F 13 DEBEFO—F 11 &Y 12
INARDELRYFETS,

a—K 13
BYTE bTestl, bTest2;

void main (void)
{
switch (bTestl)
{
case
{
asm("MOV [ bTest2], 0x1");
break; B

asm("MOV [ bTest2], 0x2");
break;

asm("MOV [ bTest2], 0x3");
break;
}
default:
{
asm("MOV [ bTest2], 0x4");
}

30.3—KF 13 ® ROM A=

Cubput
Show output from:

Starting MAKE .

creating project. mk, - no changes

Amain.c

Lirking..

Lk info: area “virual_registers' uses 2 bytes in SRAM page 0
Lk info: area 'data’ item of 1 bytes allocated in SRAM page 0
Lk info: area 'data’ item of 1 bytes allocated in SRAM page 0

TS CICTT T ot o ey e T TS Tl o T Tt

ROM 4% full. 545 out of 16384 bytes used [does not include absolute areas].

Fiakd 1% full. 4 butes used [does not include stack usage).
B uilt with ICCMBC 5TD W7.05.00

HARSALY 6: PSoC 1 DEVREIRE

PSoCl TIKTEYMZE#HRAIFICERIN-T 2B/ HYE
BA EHDOEYN A EHEYNEET 51012, THOD
RARVERBEBEFICKYE I EHICEERYVLTTER
FTEHIENTEET, YRVIEBEEHICK>TEHRIZHS
BEMNHYET, O—F 14 £a—K 15 X EHRADE VL E
BT HHEEERLTVET,

a—K 14

BYTE bTestl, bTest2, bTest3;

volid main (void)

{
/* To set first, sixth and eighth bit
of the variable */
bTestl = (0xAl);

/* To clear the second and the
seventh bits the variable */
bTest2 = bTest2 & (0xBD);

/* To invert the second, fifth and
eighth bits in the variable */
bTest3 = bTest3 ~ (0x92);

}

EHIE. EHOEVLDOEREEL. 1 DULOEYIDESR
AOMDEYNIEEEZEZ FTITRELAEITNIEESELE
B EVrERETI-OICHEBEEFEFEALEYT, chd
DEAEIL. XOR,AND, &L OR BIHZEEALEST, a—
K 14 (28 % T B.asm O—FEIUTOKI<TaZcorE
>.Ist 774 )L (Workspace>Output Files) IZERBEINET,

/* To set first, sixth and eighth bit
of the variable */

bTestl = bTestl | (0xAl);

__text start| main| main:

62 DO 00 MOV REG[0xDO], 0x0

2E 03 Al OR [bTestl], 0xAl

/* To clear the second and the
seventh bits the variable */
bTest2 = bTest?2 & (0xBD);

62 DO 00 MOV REG[0xDO0], 0x0
26 02 BD AND [bTest2], 0xBD

/* To invert the second, fifth and
eighth bits in the variable */
bTest3 = bTest3 ~ (0x92);

62 DO 00 MOV REG[0xDO0], 0x0

51 04 MOV A, [bTest3]

31 92 XOR A,0x92

53 04 MOV [bTest3],A
WWW.CYpress.com XE%S: 001-82519 Rev. *A 13
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address: 8F FF JMP address

#F MOV REG[0xD0],0x0 @4ldk.yo—nNI)ILZT#
[bTestl/bTest2/bTest3 1M RAM R—SHE4yhLET,

EHDHAANE—DEYRTH DM, FHIFEHTEESN
TWSTRTHOEYARIBIZEIVE T/ BEShTWSIEE
(&, 3—F150O K51, BEEFVLTEERLTEELET,
DT A . XOR, AND, BELUPOREYH1H A4 JLELIMOVER
SEFEALET,

E MR ORTICET IV AVILEERRNBICETHelpl >T
Documentation | I Compiler and Programming
Documents 1IZ#% % Assembly Language User Guide .
PSoC Designer M{F&k A5, lnstruction Set Summary 1%
SBLTZE,

a—K15

BYTE bTestl, bTest2;

void main (void)

{
/* To clear the first and the second
bits and set the third bit of a three
bits variable */
bTestl = 0x04;

/* To invert the variable */
bTest2 = ~ (bTest2);
}

ZUTD.asmaA—FIZLUTOEYTY,

BYTE bTestl, bTest2;
void main (void)
{
/* To clear the first and the second
bits and set the third bit of a three
bits variable */
bTestl = 0x04;
__text start| main| main:
62 DO 00 MOV REG[0xDO0], 0x0
55 02 04 MOV [bTestl], 0x4

/* To invert the variable */
bTest2 = ~ (bTest2);
62 DO 00 MOV REG[0xD0], 0x0

51 03 MOV A, [bTest?2]

73 CPL A

53 03 MOV [bTest2],A
address: 8F FF JMP address

X MOV REG[0xDO0], 0x0 @afvld.
lbTestl/bTest2/bTest31ZE D RAM R—UBEEH/ELE
3-0

HARSAY 7: CaA—RDI75vy aEARE LY
EITEROFE

I—R AEYFEAEELUTOYSLAETERAELETSH
556 BEHOIIVVADFERAELI—FEZOI—FDE
AREEMZOIEEHILIRBELICRILET,

B#na—F A XEHABIZIE Workspace > Output
Files I282< Oz R &> mp EWVST7AILESBLTE
SV, .mp FFAIIE, O—K TYFEFDII T TEERSINI:
%, ERIZE->TaA—F ATYDFEAKRIZET2#M%E
RBHLET, F= K 31 [TRT&S3IT.RAM TUYTEENDS
DIYFTEESN=IO—NILEHDT7RLRT. RAM @
FERKRICET 23R ELET,

Area  Starting address of code

Name of memory area < text

Addr Global Symbol

Size of code memory used by code area

0317 __ text_start
0317 _main

034E _functionl Functions used in code
0357 _function2

0360 _ xidata_start

0360 __texc_end
0367 __ xidata_end

Area Start End Decimal Bytes (Attributes)

TOP 0000 015A = 346. bytes (abs,ovr,rom,code)

Addr Global Symbol
0068 _ starc

0159 _bGetPowerSetting
0159 bGetPowerSetting

Area Addr Size Decimal Bytes (Attributes)

virtual registers 0002 0002 = 2. bytes (rel,con,ram)

Addr Global Symbol
0002 _r1
0003 _x0

Area Addr Size Decimal Bytes (Attributes)

Addr Global Symbol

0000 data start

0000 bTest Global variable used in code

i O—K/RAM IU7QFMIZOVTIE C SEIV/(5
aA—H— AAK. Y3y 6.9, . B8LUT7EVITYEEN
—H— HAR 223> 5.1 FSBLTIZELY,

B DI—F YA XEFHRBIZIE. .mp I7MILADBEEEE
BRLET., hRZL TU7CHARZEELTLVEMES. T
THILETIE, TRTOI—Y—FEHEBEA Ttextya—F TV
TICRBInFEY (B 32), ® 32 TIE.a—FK 16 TEEIN
f=Tmain1. Tfunction1l. & XU function2 IR T FL X%
RLTWET, Tmain]@a—F A XZHARBEHIZIE.
Tmain]M7FLAMSUT OB (CHFETfunctionl])
FELR%EBIEFET, Tmaini®H A X[ 55751+ (0x034E —
0x0317 = 0x0037) T. lfunctionlli& 9 /31 k (0x0357 —
0x034E = 0x0009)T. lfunction2(& 9 7/\A/k (0x0360 —
0x0357 = 0x0009)TY ,
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int bTest;

void main (void)
{

bTest = ++bTest;
}

void functionl (int a)
{ at+;
return;

}

void function2 (int b)
{ b--;
return;

}
32.mp Z7AINEFERLIzIovI a5t E

Area Addr Size

text 0317 0045

Addr Global Symbol

0317 text start
0317 _main

034E _functionl
0357 _function2
0360 xidata start
0360 _ text end|
0367 _ xidata end

O—FETEEZEHETSHICE, B OGS OERTHRMZEE
ET20LENHYET, ERHOHSOETHBMERARSICIE
Help > Documentation > Compiler and Programming
Documents ][Z# % Assembly Language User Guide,
PSoC Designer M{F§k A5, lNnstruction Set Summary %
SHBLTESL, ROICPU 4099 AL IOWRIE., &
[EETTHDITRLEL CPU /OVIHERHBELET, if
DERITHMEFARB(ZIE, CPU /Oy EHT. ZDEE
BEYT. UTOERSIL, BG52—FTOERTEHEOE
H&ERLET,

il 1: kD KS5122ETwhile (1) JL—TZEY EIFET,

volid main (void)
{
while (1)
{
}
}

asm<ZOZrofrE> st T7A I TEREShzTwhile (1)1/L
—J2&% T H.asma—FIELUTOBYTT,

while (1)
{

}
address: 8X XX JMP

address
IMPEG (X, EITIZ5 CPUY AL MYET, CPUYOY
IH24MHZTHNIK, IMPE S D ETHEBIELITIZHYET,

1 —
5 X Hs = 0.208 ps

CDEETIE., CPUIZL, #50.208uSH1=Y1 (IMP) S EEIT
L. DFY1##H1=Y(1/0.208) = 480 5 D 5EETLET,

151 2:
ROESICEMEMEDOHERETLET .

void main (void)
{
BYTE bTestl, bTest2;
while (1)
{
bTestl = bTestl + bTest2;
}
}

®hs.asmaI—KRIELUTOERYTY,

BYTE bTestl, bTest2;
while (1)
{
bTestl = bTestl + bTest2;

addressl: 52 01 MOV A, [X+1]

address2: 05 00 ADD [X+0],A
}

address3: 8X XX JMP addressl

HII—FDETIE6 (MOV) + 8 (ADD) + 5 (JMP) = 194
Ay Y4 LhYET, COHE, FHIaR LY
19/3=6.334 1YL TY, CPUYOYIH24MHZzTHNIE,
A—F2RORTRMIIUTIZEYVET .

19
24,000,000

s =0.792 ps

ZOL—FTIE, CPUIE. 0.792/3 = 0.264uSH =Y 18 5 EE1T
L. 2FY1#H =Y (1/0.264) = 37.9F D HEETLES,

FEROHARSAUIEa—FORBLIZHRIEES, TOHIZ
I%. ImageCraft A /X1IFEDLDEHNIE. —HEMHE
DEHYET, I7—LIzT7ORFEPTLIIFAFERIZTNL
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